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Word 2000:  Basics

Personalized Menus
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The very first time you open PowerPoint 2000 only the most commonly used menu commands will display in the menu.  To see additional menu commands, click the double arrow at the bottom of the menu.   As users access menu commands they will display on the menu list.    The more often a menu item is used the higher on the menu is will appear.  The less often a menu is used the further down the menu it appears and eventually drops from the “personal menu”.   To turn off the personalized menus and display all menu commands choose Tools, Customize and go to the Options tab.   Remove the check mark from the Menus Show Recently Used Commands First check box and click Close.

Toolbars

When you open Word you will see two toolbars displayed:  Standard and Formatting.  If any of these toolbars disappear, you can regain them by right clicking on any visible toolbar and then selecting the toolbar name from the list that displays.  A toolbar can also be displayed by choosing  View, Toolbars, and selecting the  toolbar.
A new default setup and space saving feature of Office 2000 displays the Standard and Formatting toolbars in one row instead of two.  To change this option so the Formatting and Standard toolbars appear on separate rows choose  Tools, Customize, Options tab and deselect the Standard and Formatting Toolbars Share One Row option.  

Window Control Buttons

When using Office 2000 each open document has its own separate window with its own separate window controls.   In addition, each Word document has its own button on the taskbar.  Click on the button located on the taskbar to switch between documents.  

Managing Documents and Files

The best way to keep track of files is to set up some type of folder structure and use this structure to organize your work.

Viewing Documents and File Information

Viewing file information and previewing files can help you manage your documents.  For example, you can preview a file before you open or print it so that you know you are working with the right document.  Or, you can view file information to find out which is the most recent version of a document on which you have been working.

Open Dialog Box 
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File  |   Open  or click on the Open icon in the toolbar 

  The Open dialog box lists the files in the current folder.

Changing the View in the Open Dialog Box
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By default, files are listed by name in the Open dialog box.  To change to a different view, use the Views button in the dialog box.  

[image: image6.bmp]Select from List, Details, Properties, or Preview.  
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[image: image8.bmp]Choose the Arrange option from the View pull down menu and rearrange the order of the file icons.  

History Folder

The History folder contains shortcuts to files and folders recently worked with.  The History folder can contain up to 20 shortcuts for each file type.  Office will only display shortcuts in the History folder, which are appropriate to the open application in use.  

Understanding Folders

· Folders are a way of organizing files

· Folders are analogous to the file drawers and file folders you use in your office to help you organize and locate your paper files.

· You can locate files more easily if you store related files together in a folder.

· For example:
you could store all business letters you create in Word in a folder named  \Business Letters and all your proposals in a folder names \Proposal
Note:  Do not  store files you create in the folders where your program files are stored.  If you ever have to reinstall or upgrade Word, you could lose any files you stored in the program folders.  Create your own folders and subfolder for file storage.

What you need to know about creating and saving documents

Understanding File Names

The first time you save a new document, you must give it a name and assign it to a disk drive and folder.  

With previous versions of Word, you were limited to an eight-character file name, with a three-character extension.  

With Windows 95, you can now use longer file names.  

· You can type as many as 255 characters, including spaces

· You can use letters   A - Z (uppercase or lowercase), numbers 0 through 9, hyphens (-) ,  underscores ( _ ), and exclamation points  (  !  ).

· Legal characters include  !,  @, #,  $,  %,  ~,  ` , &,  (  , )   _  ,  -  ,  {  and }

· You can not use  \  ?  :  *  "  <  >  |

· Word provides its own extension   .doc

Note:  If you want a file to be listed first when sorted alphabetically, precede the file name with an underscore character.

For example:  

_list first

Opening and Saving Files

The first time you use   File  |  Open   or   File  |  Save As  ,  Word assumes that you want to open or save a document in the MY DOCUMENTS folder.

[image: image9.bmp]
To select a different drive or folder, click on the pull down arrow to the right of the LOOK IN (File  |  Open) or the SAVE IN (File  |  Save As)  dialog box.

Select the Drive or Folder.

Printing Files

You can choose  File  |  Print to print the open document.  

If you want to print several documents with the same printing parameters simultaneously,  use the Open dialog box.
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Select one or more files you want to print

2. Click the Commands and Setting button,  button on the far right of the dialog box 

3. Or  right-click the mouse and choose Print.

4. In the print dialog box, choose  OK

Word open the files, prints them, and then closes them.
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A new feature in Office 2000 allows the user to print multiple pages on one sheet of paper.  From the Print dialog box under the Zoom option click on the pull down menu for page options.

Copying or Moving Files

You can use the Open dialog box to copy or move selected files from one location to another.

Copy

1. Select one or more files you want to copy.

2. Right-click the files, and then choose copy in the shortcut menu that appears.

3. Use the Look In drop-down list to select the drive or folder where you want to place the 

copy.

4. Right-click the drive or folder and then choose Paste.

Move

1. In the Open dialog box, select one or more files you want to move.

2. Right-click the files and then choose Cut from the shortcut menu.

3. In the Look In drop-down list, select the drive or folder where you want to move the file.

4. Right-click the file list box, and then choose Paste.

Delete

The following steps show you how to delete a file from Word:

1. In the open dialog box, select the files you want to delete.

2. Right-click the selected files(s) and choose Delete.

3. A dialog box asks you to confirm the delete, choose Yes to delete the files; choose No if you

don't want to delete them.

Setting the Default Folder

To change the default folder, follow these steps:

1. Choose  Tools  |   Options

2. Select the File Locations tab

3. Select Documents in the File Types list

4. Click Modify to display the Modify Location dialog box

5. Select the folder you want to use as the default from the list box or type the full path name for the folder in the Folder Name text box.

6. Choose OK and then choose Close.
Changing Views
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You can use the View menu and the View buttons on the bottom left of the screen to view your document in different ways.  Changing the view does not change the document in any way.

· Normal: commonly used view for creating and editing;

· In Office 2000, Online Layout has been replaced with Web Layout: wraps the text at the window rather than appearing as it would print; makes online reading easier;

· In Office 2000 the Page Layout has been replaced with Print Layout: useful for final editing as it displays headers and footers;  

· Outline: displays the outline toolbar;

· In Office 2000 the Master Document has been combined with the Outline view:  for working with long documents;

· Full Screen: all toolbars, status bar, and scroll bars disappear.  Press Esc to retrieve [image: image13.png]e | o
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· In Office 2000 the Document Map is located as a button in the Standard toolbar:
 the document map view displays a pane on the left, which lists all the headings.  Click on any heading to go directly to that location.  This is useful for navigating large documents.
Positioning the Cursor

	
Position Cursor
	
Keystrokes

	One word to the left
	<CTRL><Left Arrow>

	One word to the right
	<CTRL><Right Arrow>

	Beginning of current paragraph
	<CTRL><Up Arrow>

	Beginning of next paragraph
	<CTRL><Down Arrow>

	Up one screen
	<Page Up>

	Down one screen
	<Page Down>

	Up one page
	<CTRL><Page Up>

	Down one page
	<CTRL><Page Down>

	To the beginning of the document
	<CTRL><Home>

	To the end of the document
	<CTRL><End>

	An exact location in the document
	<CTRL><G>


Selecting Text to Format
To change the format of some text you have typed, you must first select (block) it.  

	To select:
	Do this:

	Word
	Click anywhere in the word.

	Sentence
	Press the <CTRL> key and click in the sentence.

	Line of text
	Place the pointer in the left margin and click once.

	Paragraph
	Place the pointer in the left margin beside the paragraph and double click.

	Document
	Place the pointer in the left margin and triple click or press <CTRL><A>.

	Custom Selection
	Hold the left mouse button down and drag across the text or click once at the beginning of the text to position the I-beam, then click at the end of the text while holding down the <Shift> key.


To deselect text, click anywhere outside the selected area.  You can also format text as you type.  Click any formatting button, then type.  To turn off that formatting style, click on the button once more.

Click and Type


A new feature for Word 2000.  This new feature will only work in the Print Layout or Web Layout view.   Double click the mouse in a blank space to insert text.  The text alignment will vary depending on where the Click and Type feature is being used.

Using the Formatting Toolbar

[image: image14.bmp]
The formatting toolbar displays buttons for the most commonly used formatting options. [Note: if the toolbar is not visible, you can turn it on by choosing Toolbars from the View menu.] From this toolbar you can choose styles, font/point size and other attributes, alignment, etc.
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Creating a Bulleted or Numbered List  

To create a bulleted or numbered list: type the list, select it, and then click the Bullets button or the Numbering button.  

To remove bullets or numbers from a list: select the list and then click the Bullets or the Numbering button.  (When you select a list, you can’t select the bullets or numbers.)

[image: image16.bmp]To indent a list, use the Increase Indent or Decrease Indent button on the toolbar. 

To modify the color or style of  bullets or numbers: select the list and then choose Bullets And Numbering from the Format menu.
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New in Word 2000.  Word 2000 provides a variety of picture bullets users can choose from.  To select a picture bullet choose   Format,  Bullets and Numbering.    

From the Bullets and Numbering dialog box select the Picture icon.  

Character Formatting Shortcuts

	Attribute
	Keyboard Shortcut

	Bold
	<CTRL<B>

	Italic
	<CTRL<I>

	Underline
	<CTRL<U>

	Word Underline
	<CTRL<SHIFT><W>

	Double Underline
	<CTRL<SHIFT><D>

	SUBscript 
	<CTRL<=>

	Superscript
	<CTRL<SHIFT><=>

	Up one point
	<CTRL<]>

	Down one point
	<CTRL<[>


Additional Font Choices 

For choices besides those on the formatting toolbar, choose Format  |  Fonts.  This displays all font related choices such as sub and superscript, small caps, and more.
New in Office 2000.  WYSIWYG (  What You See Is What You Get.   When the Font button is selected from the Formatting toolbar a WYSIWYG menu will display.   This new feature allows users to see what the font looks like before they select it.

Default Format

To change the font, font size, and other character formats that are preset for Word, click on 

Format  |  Font, select the features you wish to use in the current document and all new documents, then click on the Default button. 
[image: image18.bmp]
Format Painter  

Once you’ve formatted text to look the way you want, use the Format Painter button to copy the formatting to other text.  Click anywhere in the text that is formatted, then choose the Format Painter from the formatting toolbar.  This turns the mouse icon into a "paint brush" which can be applied to any text that needs formatting.  Click once on the button to paint one time; click twice to turn the painter on for extended use.  Click on the button to turn it off.
Undo/Redo  
You can undo many commands.  To undo the last command, click the Undo button.  To see a list of the commands that you can undo, click the drop-down arrow next to the Undo button. You can also use the Redo button in the same way.

Moving and Copying Text and Graphics
There are two methods for moving/copying text:

1)
Drag-and-drop is the easiest way to move or copy a selection a short distance. Dragging a selection moves it to a new location. To copy, hold down the CTRL key while dragging.

2)
To move or copy a selection a longer distance, use the Cut/Copy and Paste commands on the Edit menu. You can move or copy within a document, between different documents or between most applications. Use menus, toolbar buttons or keyboard shortcuts.
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Copy:  Keyboard Shortcut = <CTRL><C>
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 Cut:    Keyboard Shortcut = <CTRL><X>
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Paste:  Keyboard Shortcut = <CTRL><V>
[image: image22.bmp]Collect and Paste

Collect and Paste is a new feature for Office 2000.  You can cut and paste up to 12 items, text or graphics, to the Clipboard.  To access the Clipboard choose  View,  Toolbars,  Clipboard.   Items on the Clipboard will be placed on the Clipboard in the same order that items where cut or copied.  The user can paste all items, in order, by selecting Paste All or select one item at a time by selecting an icon from the clipboard.   To clear all items on the Clipboard choose the Clear Clipboard icon.

Edit, Paste Special
You can paste a link so that the text, when changed in the original location, will automatically update in the new location.  To create a link, simply copy the text/graphics as described above.  Instead of using Paste, however, select   Edit  |  Paste Special, and then click on Paste Link.  
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Show/Hide  

By depressing this button, you can view paragraph marks, tabs, indents or hidden characters on your screen.  To hide the marks, click the Show/Hide button again.

Paragraph Formatting

Paragraph marks “store” the format of each paragraph.  Be Careful About Deleting a Paragraph Mark. When moving or copying a paragraph, be sure to include its paragraph mark if you want to keep the paragraph’s formatting.
Margins and Indents:  Using the Toolbar Buttons

Word applies formats only to the paragraphs you select. You don=t have to select all of the text in a paragraph; just position the insertion point in the paragraph.
Justification: Left, Center, Right, Full
Indents: Decrease Indent, Increase Indent
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[image: image26.png]Press new shortcut key:

E—

Description
Monotype Sorts: 61622



Indents and Line Spacing:  Using the Menu
To display the paragraph formatting dialog box, choose  Format  |  Paragraph.  This allows you to change indents, spacing, line and page breaks from one location.

Hanging Indents: In the  Format   |  Paragraph box, click on Indents and Spacing and choose Hanging from the drop down list.  Select the amount of space for the indentation.

Margins and Indents:  Using the Ruler
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Both margins and indents may be set from the ruler bar.  If the ruler is not displayed, choose

 View  |   Ruler.  




A margin specifies the distance from the edge of the paper.

An indent specifies additional distance from the margin. 
You can alternatively set a margin/indent from the position of the insertion point forward in your document, or you can apply them to selected portions.

The ruler displays left and right margin settings, any indent stops, and any tab stops that have been set.

To change vertical margins, choose View  |   Page Layout.  This allows you to view and set the top and bottom margins by dragging with the mouse.

To view the exact margin setting (in inches), hold down the Alt key while dragging.

[image: image28.png]Inget AutoTert ~ BRI RS



You can see which formats are applied to text by selecting a paragraph and looking at the settings on the Formatting toolbar and on the horizontal ruler.

To change margin settings using a menu, select  File  |  Page Setup.  From this menu you can also change the page settings from portrait to landscape, or change paper size.  

Paragraph Formatting Shortcuts

	Format Feature
	Keyboard Shortcut

	Left-align text
	<CTRL><L>

	Center text
	<CTRL><E>

	Right-align text
	<CTRL><R>

	Justify text
	<CTRL><J>

	Indent from left margin
	<CTRL><M>

	Decrease indent
	<CTRL><SHIFT><M>

	Create a hanging indent
	<CTRL><T>

	Decrease a hanging indent
	<CTRL><SHIFT><T>

	Single-space line
	<CTRL><1>

	Create 1.5-line spacing
	<CTRL><5>

	Double-space lines
	CTRL<2>


Page Breaks
To insert a page break, place the insertion point where the new page should begin and either

· Press <CTRL><Enter> or 

· Choose   Insert  |  Break  |  Page Break.

If you want the new page to have a different appearance, you must create a Section Break instead of a page break.

Section Breaks
Section breaks let you divide your document into sections so that you can vary the appearance of the document.  Within a section you can have different margins, headers/footers, and columns.  The formatting of a particular section will continue until it is changed in subsequent sections.

To create a Section Break, position the insertion point where you want to begin a new section, and choose Insert  | Break  | Section Break from the menu. 

Formatting the Layout of a Section

To change the margins, paper size, paper source, or layout for a section, choose   File  |   Page Setup from the menu after you have created your section breaks. 
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Headers and Footers
To create or edit a header/footer, select    View  |  Header and Footer.  You can then type text in the header or the footer area or add codes for page numbers, date, or time by clicking on the appropriate button.  Choose the Close button on the Header and Footer toolbar to return to the previous view.

To suppress the header or footer for the first page, click the Page Setup button.  

In the Page Setup area, select “Different First Page”.    Delete header or footer text you don’t want to appear on the first page.

To delete a header of footer, from the View menu, choose Header and Footer.  Select the header and footer you want to delete, and then press the Back Space or DEL key.

To insert the Path and Filename into a header or footer, position the cursor within the header or footer and click on the Insert Autotext button and choose Filename and Path.  

Tips for Headers and Footers
· If you move the page numbers outside the header or footer area, the page numbers are still part of the header or footer. If you want to edit or format the page numbers, you need to click Header and Footer on the View menu.

· If you inserted page numbers by clicking Page Numbers on the Header and Footer toolbar, Word inserts the page numbers as part of the text in the header or footer. They are not enclosed in frames, and you can't drag them to a new location. 

· In page layout view, a quick way to switch between the header and footer and the main document is to double-click in the area you want.  For example, double-click in the dimmed header to switch quickly to that header.

Varying Headers and Footers within a Single Document
Each section in a document can have unique headers and footers or you can create different headers and footers on odd and even pages.  

To change the header or footer in one section of your document:

· Position the insertion point inside the section where you want to change the header or footer.

· Choose  View  |  Header and Footer.  Word selects the header for the section in which you're located. 

· If  you want to change the footer, click the Switch Between button instead.  

· Unlink the header or footer by clicking the Same as Previous button.  

· Create the new header or footer

· Choose the Close button to close the Header and Footer toolbar.

The new header or footer applies to the current section and to all the following sections. 

Tabs
Word sets default tabs every half-inch from the left margin.  These are represented by gray notches at the bottom of the Ruler.  If you press the Tab key on your keyboard, the insertion point moves to the next tab stop.  
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To set new tabs using the ruler:

1. Use the button on the far left of the ruler to select the kind of tab to set:
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2. Click on the ruler where you want the tab to appear.  

3. To adjust the tab location, drag to another position.



4. To delete a tab, drag the tab off the ruler with the mouse.
Some options are not available under the ruler.  To make dot leader tabs, clear all tabs, or make bar tabs, go to Format  | Tabs.

Inserting Date and Time
You can insert the date and have it remain static or update automatically.  To insert the current date, choose  Insert  |  Date and Time  from the menu.  Notice the option at the bottom of the dialog box to Update Automatically.

Inserting Page Numbers
To insert page numbers, select Insert  |  Page Numbers.  Choose options such as include in header, footer, display on first page, etc.  Page numbers, once inserted, can be moved through the Header and Footer view.  Select the frame around the page number and drag it to a new location.

Case Change
To quickly change the case of text, select the text to be changed, then choose  Format  |  Case Change 

Spelling
To start the spell checker, choose  Tools  |  Spelling and Grammar, or press the shortcut key, F7.

Word pauses when it finds a possible error, and the word in question appears in the Not In Dictionary box.  If Word questions a specialized term that is spelled correctly, choose the Add button to add the word to the current custom dictionary.  The next time you check spelling, Word will not question the new term unless it is misspelled.

If Word finds an error that you typically make, select the correction in the Suggestions box or type the correction in the Change To box.  Then choose the AutoCorrect button.  Click on Yes if asked about turning on the Replace Text As You Type option.  The next time you make the same error, Word corrects it as you type.

Symbols and Special Characters
You may choose to select characters to insert from various character sets or you may also assign a keyboard shortcut to any character.  Assigning a keyboard shortcut allows you to insert that character at any time without opening the menu.

To insert a symbol, choose  Insert  |  Symbol from the menu.  From that dialog box, select the font you want, then double-click the symbol to insert it in your document.

To enlarge the symbol, highlight the symbol and choose a larger point size.


(   ½   ©
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To create a shortcut for the symbol, click on the desired 

symbol, then click on Shortcut Key.  Select a series of keystrokes not yet assigned.  
Multiple Windows - One Document
You can split the window into two parts to view different sections of the same document.  This is useful for doing drag and drop from one location to another.  Select Window  |  Split and click to set the location for dividing the window.  To set it back to one window choose: Window  |  Remove Split.

Multiple Windows - Two Documents
You can view multiple documents simultaneously by first opening them, then choosing 

Window  |  Arrange All.  To return a window to a full screen, click on the maximize button.
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Print Preview

Use the Print Preview button on the Standard toolbar to display a document, as it will look when printed.  You can edit the document in this view, making last-minute changes before you print.  Use the Print Preview toolbar (or select Print Preview from the File menu) to change how the document is displayed and to zoom in or out.

This is an example of the 


File  |  Save As   dialog box
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